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1. Introduction

The following is an SRD (Software Requirements Document) that will define the requirements and specifications of the State Transition Diagram Design Software that is being developed for the Company. The Co. is a software developing co. that requires software to help them with the creation of state transition diagrams. Thus, the developing team will be in charge of the development of such tool. The application will be used so that the consultants of the co. may conceptualize diagrams for the specific needs of the co.. With this diagram, the marketing team can improve readability for their purposes, without affecting the logistic of the original diagram. The CEO of the company may only view the diagram for approval, presentation, or other personal uses without modifying the diagram.

Requirements have also been gathered through interviews and email with the CEO, the marketing manager, consultants, the IT team and janitorial team manager.

1.1. Purpose

The SRD once agreed upon, would be an understanding between the Co. and the developing team, describing how the system will behave. This document makes sure that everyone involved in the process of developing the software and everyone who will use this software both agree on the problem and how the solution to the problem will be implemented.  

This document is written for the CEO, Marketing team, Consultants, the company’s IT team, and our developing & maintenance team.

1.2. Scope

The product (STDD) is a software program that helps the user develop a state transition diagram, check for the consistency of diagrams created on it, save, open and modify them. The software provides the ability to differentiate users allowing them to perform different tasks. 

The software will not output bitmap images, print diagrams, or allow network interconnectivity, understood for this that each program installed on different machines is independent and do not share user/password information or other.

The beneficial part of the SW is easier diagram developing, with a user-friendly interface, and the checking of consistency. 

1.3. Definitions, Acronyms and Abbreviations

The following is a list of definitions, acronyms and abbreviations that will help you better understand the document.

1.3.1. Definitions

STATE
The condition of an Object at any one time i.e. certain attribute values.

TRANSITION
A change of State caused by an Event.

STD (state transition diagram)
A diagram showing the lifecycle of an Object/Class, the Events affecting their States.

PRIVILEGE
An option that a user has access to.

1.3.2. Acronyms

SRD
Software Requirements Document

SRS
Software Requirements Specifications

XML
Extensible Markup Language

GUI
Graphical User Interface

IT
Information Technology

CASE
Computer Aided Software Engineering

N/A
Not Available [or Admissible]

S
Steven Faguy

X
Xuan Ngo

C
Cedric Billebaud

V
Vincent Leclerc

J
Jose Alberto Vazquez

1.3.3. Abbreviations

s/he
he/she

Co.
Company

SW
Software

PR
Product

STDD3000
State Transition Diagram Designer 3000

1.4. References

· A list of references that might have been used to complete this document

Title
Author
Version
Date

(yyyy/mm/dd)

IEEE Template
Computer Science
1.0
N/A

IEEE Example
Computer Science
N/A
N/A

OO Example
GBV Team F
N/A
N/A

CCI Dictionary Definition
Computeruser.com
N/A
2002

1.5. Overview

CEO, Marketing team, Consultants, the company’s IT team, and our developing team

Section 1 of this document should be read by everyone.  This section gives the reader all the information needed to read the rest of the document as well as a general overview of the problem, the solution and describes how the solution will benefit the company.

Section 2 of this document should be read by everyone.  This section gives a detailed textual description the system, describes how the system might tie into already existing systems, lists the functionality’s that will exist in the system, depicts the types of users of the system, describes general constraints and indicates the assumptions and dependencies.

Section 3 of this document should be read by the developing team in its entirety.  For those who would like more information on a specific functionality they can consult this section to get more information on it.  This section contains a structured and detailed explanation of all functionality’s, the external interfaces to the system, performance requirements, design constraints, quality attributes and other requirements.    

Reader Type
Recommended Reading

CEO
Section 1 (all), 2 (all)

Marketing Team
Section 1 (all), 2 (all)

IT team
Section 1 (all), 2 (all)

Consultants
Section 1 (all), 2 (all)

Developing & Maintenance Team
Section 1 (all), 2 (all), 3(all), 4(all)

2. Overall Description

2.1. Product Perspective

STDD3000 will be used as a CASE tool. It is similar in its functionalities to bigger CASE tools such as Rational Suite Enterprise and similar packages. Apart from the obvious use of the Microsoft Windows operating system, the SW will be independent and totally self-contained. It will use basic system calls to open and save file and to manage windows.
The software will use a standard user interface (see section 3.3.1), which includes a main window composed with a main menu, a toolbox and a canvas.

Additional comments:

STDD3000 will use basic hardware such as a hard drive or similar devices to store the saved files, a mouse/keyboard for interaction with the user and the obvious display monitor.

2.2. Product Functions

Below is a list of all functions that can be found in the system with a description of the function and its priority.  The priorities range from 1 to 3, with 1 being the highest priority and 3 being the lowest.  If a requirement has been removed the word “removed” will be written as opposed to a numeric priority.

Priority
Detail

1
Must have

2
Should have

3
Nice to have

removed
Removed from requirements

Domain Model of STDD3000:
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2.2.1 File Menu Functions

The file menu groups common functions for file management. These functions are Open, New, Save, Save…as, and Exit (Open Recent, Login as have lower priority, they might be implemented on the second version of the program). These functions are described in the next table, along with its priority given 1 as the highest and 3 as the lowest.

Function
Description
Priority

Open
The open function opens a file of a previous STD
1

New
The new functions creates a new canvas for a new STD
1

Save
The save function saves the current STD on a file
1

Save…as
The save… as function saves the current STD on a file with a different name and/or location if the STD is already saved with another name.
1

Exit
The exit function ends the program
1

Open Recent
Opens the last STD created/modified in the current machine on the program
3

Login As
Changes the user in order to change the privileges 
1

Change password
Change the selected user’s password
2

Some of the above functions may not be open for some users. As stated before, the Consultants are the only ones that have access to all functions, CEO has only the open, exit functions available, while Marketing will be able to modify text comments but not create or modify States or Transitions, thus they can save the file.

2.2.2 Tools Menu Functions

Function
Description
Priority

select
The user selects any objects from the STD.
1

addState
The user adds a new state in the STD.
1

addTransition
The user adds a new transition arrow in the STD.
1

delete
The user deletes any object from the STD.
1

commentBox
The user writes comments anywhere in the STD.
1

moveObject
The user moves a state or a comment box anywhere in the STD. In the case of a state, it will affect all of its transition arrows from or to different states and these transition arrows will shrink or expand accordingly to the displacement.
1

checkConsistency
The user utilizes this function to verify the correctness of the DFA. The function will automatically check in the STD corresponds to the DFA definitions. If the STD is inconsistent, the system will popup a window pointing out the errors.
1

2.2.3 Description of property functions

Here, functions are organized into four different parts: the property description of a specific state or transition, a list of all drawn states, a list of all drawn transitions and a property description of the state transition diagram (canvas). Each of them characterizes the title of one GUI tab, inside the Property Dialog window.

In order to have a general view of the Property Dialog window, please see section 3.3.1.

Note:

For all function names having “set” as prefix, refer to sequence and collaboration diagrams that only have “set” as function name.

Function
Description
Priority

viewStateDescription
The user selects a state object from the canvas or the state list to get into the detailed view of this particular state. If the user selects more than one state at the same time, then she/he will not be able to see the state description view. Thus, this one will appear in grey style and an error message will be prompt to her/him.
1

viewTransitionDescription
The user selects a transition object from the canvas or the transition list to get into the detailed view of this particular transition. If the user selects more than one transition at the same time, then she/he will not be able to see the transition description view. Thus, this one will appear in grey style and an error message will be prompt to her/him.
1

viewStateList
The user is permitted to select only one state object and cannot change the name or its ID. 
1

viewTransitionList
The user is permitted to select only one transition object and cannot change the name or its ID.
1

viewSTDDescription
In that function, the user will be able to know the main characteristics of the STD.
1

Apply
The user clicks on that button in order to save all modified data such as names, comments, colours and state status in memory.
1

Ok
The user clicks on that button in order to save all modified data such as names, comments, colours and state status in memory and close the Property Dialog window.
1

Cancel
The user clicks on that button in order to cancel all changes made after the last time s/he clicked on “Apply”. This function then closes the properties window.
1

2.2.3.1 viewStateDescription Inner Product function

For those functions, the user must have followed last requirements for the state description function. These functions are internal functions of the state description function:

Function
Description
Priority

setName
This function lets the user specify a name for the state that she/he selected.
1

setColour
This function lets the user specify a colour for the state that she/he selected. Only the outline will have this colour. The rest of the state will be in the colour of the background.
3

setInitialState
This function lets the user specify if the selected state is the initial state or other type of state. Only one state can be an initial state
1

setFinalState
This function lets the user specify if the selected state is a final state or other type of state. It is possible to have many final states in the state transition diagram.
1

viewInputs
This function lets the user see what transitions come from another states and go to this particular state.

The user can only visualize their transition name and ID.
1

viewOutputs
This function lets the user see what transitions leave this particular state and go to another states.

The user can only visualize their transition name and ID.
1

setComment
This function lets the user comments the actual state.
1

2.2.3.2 viewTransitionDescription Inner Product function

For those functions, the user must have followed last requirements for the transition description function. These functions are internal functions of the transition description function:

Function
Description
Priority

setName
This function lets the user specify a name for the transition that she/he selected.
1

setColour
This function lets the user specify a colour for the transition that she/he selected.
1

viewLaunchedStates
This function lets the user see what is the launched state.

The user can only visualize its state name and ID.
1

viewEndingStates
This function lets the user see what is the ending state.

The user can only visualize its state name and ID.
1

setComment
This function lets the user comments the actual transition.
1

2.2.3.3 viewStateList Inner Product function

For those functions, the user must have followed last requirements for the state list description function. These functions are internal functions of the state list description function:

Function
Description
Priority

selectState
This function lets the user see what are the states that have been already drawn on the canvas.

The user can only visualize their state name and ID (No possible modification).
1

launchStateDescription
This function allows the user to visualize the selected state property.
1

2.2.3.4 viewTransitionList Inner Product function

For those functions, the user must have followed last requirements for the transition list description function. These functions are internal functions of the transition list description function:

Function
Description
Priority

selectTransition
This function lets the user see what are the transitions that have been already drawn on the canvas.

The user can only visualize their transition name and ID (No possible modification).
1

launchTransitionDescription
This function allows the user to visualize the selected transition property.
1

2.2.3.5 viewSTDDescription Inner Product function

For those functions, the user must have followed last requirements for the About DFA function. These functions are internal functions of the About DFA function:

Function
Description
Priority

setName
This function lets the user specify a name for the state transition diagram that she/he would like to title.
1

viewStateNumber
This function lets the user see how many states there are in the diagram: that one is a simple integer number.
1

viewTransitionNumber
This function lets the user see how many transitions there are in the diagram: that one is a simple integer number.
1

setComment
This function lets the user comments the state transition diagram.
1

2.2.4 Description of Help Menu functions

The Help menu just portrays the information of the developers of the software, as well as a handy help file for the use of the software.

Function
Description
Priority

About
Displays a window with information of the developing group.
1

Help
Displays a help file in html format
1

2.3. User Characteristics

· Description of each actor of the system, the actors education level, frequency of system use, how they use it, experience and technical competency.  It gives reasons why certain requirements are specified.

The following is a list of the actors in the system and their description.

Actor
Description

CONSULTANT
The consultants will have full permissions on the software. They will frequently use it. Therefore they require a high level of knowledge of the software to use it.

MARKETING
The marketing team will use the software to view and modify comments and labels in STDs created by the consultants. It will be able to modify the layout of the STD without modifying its logic. It will also be allowed to save the modified STDs. They will sporadically use it. Therefore they require a moderate level of knowledge of the software to use it.

CEO
The CEO will use the software for viewing purposes only. They will sporadically use it. He does not require a high level of knowledge of the software to use it.

2.4. Constraints

STDD3000 must be secure in terms of the privileges accorded to specific users. We do not see a need for encryption of usernames and passwords since the SW will be used internally in the Company. Apart from schedule constraints, every functionality with a priority level of 1 should be implemented and working properly.

2.5. Assumptions and Dependencies

The software will run under the Microsoft Windows 2000 Operating System. It will make several system calls to this platform to perform basic actions such as saving and opening and manage windows. We assume that the computers running STDD3000 is up-to-date in terms of hardware although the software will be able to run on less powerful computers. We shall code the software using C++ and Microsoft Foundation Classes.

3. External Interfaces

3.1 Functional Requirements

Priority
Detail

1
Must have

2
Should have

3
Nice to have

removed
Removed from requirements

3.1.1 Details for the File menu functions

Use Case for the File Menu:
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3.1.1.1 Open

Description
Once the program is running, the user can open a previously created STD saved on a file.

Priority
1

Status
Detailed Description

Actors
CEO, Marketing/sales, Consulting services

Pre-Conditions
The program is running in the machine, the file exist in the local machine’s hard drive.

Flow of Events


     Basic Path
-With the mouse the user clicks on File menu, which opens the menu, where the user then clicks open. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the File menu, select open and hit the Enter key. Or

-The user can press ctrl + O and this will open the file.

Any of these options will open another window, where via graphical interface navigation the user can locate a file in the system’s hard drive. The file is selected and double-clicked OR the user can press enter OR the user can click on Open. The function Check Validity for a file is called.



     Alternative Paths
-The file cannot be found, so the user closes the open… window (via Escape key or by clicking the Cancel button)

-The file selected is not a valid STDD3000 file, so it is not opened, the program goes to the initial state (no canvas or STD open)

Post-Conditions
The program has opened a file on the canvas.

Related Use Cases


     Used Use Cases


Extending Use cases


Sub function of open:

checkValidity 

Description
When the command open has been selected, the program verifies that the file is valid for the STDD3000

Priority
1

Status
Detailed Description

Actors
Open Function

Pre-Conditions
The file to open has been selected

Flow of Events


     Basic Path
The program reads the first lines of the file to check validity, and then opens it.

     Alternative Paths
The file is not a valid file (even though it has the same file extension) type.

Post-Conditions
The program has opened a previously saved file 

Related Use Cases


     Used Use Cases


Extending Use cases


Sequence Diagram of Open:
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Collaboration Diagram of Open:
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3.1.1.2 New

Description
Once the program is running, the user can open an empty canvas, ready to start the creation process of an STD

Priority
1

Status
Detailed Description

Actors
Consultants

Pre-Conditions
The program is running in the machine and the user has the privilege to create an STD.

Flow of Events


     Basic Path
-With the mouse the user clicks on File menu, which opens the menu, where the user then clicks new. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the File menu, select new and hit the Enter key. Or

-The user can press ctrl + N and this will open a new empty canvas.

     Alternative Paths


Post-Conditions
The program has opened an empty canvas file 

Related Use Cases


     Used Use Cases


Extending Use cases


Sequence Diagram of New:
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Collaboration Diagram of New:
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3.1.1.3 Save

Description
When an STD has been created, the user can save it into a file. This creates such file with a specific extension only usable by the STDD3000. If the file is already created, it updates the file.

Priority
1

Status
Detailed Description

Actors
Consultants and Marketing – Save… as function

Pre-Conditions
The program is running in the machine and the user has the privilege to save an STD.

Flow of Events


     Basic Path
-With the mouse the user clicks on File menu, which opens the menu, where the user then clicks Save. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the File menu, select Save and hit the Enter key. Or

-The user can press ctrl + S
If the file has already been saved into a file (that means, that it is not the first time the user saves the current STD) the program will just update the file. If not it runs the Save…As function.

     Alternative Paths
The user can cancel the function by clicking on cancel or by pressing the escape key.

Post-Conditions
The program writes the STD on a file. 

Related Use Cases


     Used Use Cases


Extending Use cases


Sequence Diagram of Save:
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Collaboration Diagram of Save:
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3.1.1.4 Save As

Description
It asks the user to give a name and place of where to save the STD, or if the current STD has already been saved in a file, it saves it again under another specified file name.

Priority
1

Status
Detailed Description

Actors
Consultants and Marketing …save Function

Pre-Conditions
The program is running in the machine and the user has the privilege to save an STD.

Flow of Events


     Basic Path
-With the mouse the user clicks on File menu, which opens the menu, where the user then clicks Save As. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the File menu, select Save As and hit the Enter key.

Any of these options will open another window, where via graphical interface navigation the user can locate a directory in the system’s hard drive where the file will be saved. Then the user has to type in the desired name for the file in the File Name text box and click Save As or press enter. This writes to disk.

     Alternative Paths
The file name desired is already in use by another file, a pop-up window will appear asking if the user wants to overwrite the previous file, the user has the option of yes or no, if yes, the file is saved under the name selected, overwriting the file, if no is selected, the user will be taken to the save window to change the name of the file. The user can cancel the function by clicking on cancel or by pressing the escape key.

Post-Conditions
The program has saved the STD on a file, with a specified file name. 

Related Use Cases


     Used Use Cases


Extending Use cases


Sequence Diagram of Save As:
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Collaboration Diagram of Save As:
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3.1.1.5 Exit

Description
It closes the program, verifying if the user has saved the STD, and asking the user if he wants to save the file or exit the program without saving.

Priority
1

Status
Detailed Description

Actors
CEO, Marketing/sales, Consulting services

Pre-Conditions
The program is running in the machine

Flow of Events


     Basic Path
-With the mouse the user clicks on File menu, which opens the menu, where the user then clicks exit. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the File menu, select exit and hit the Enter key. Or

Any of these options will run the verifySavedStatus function. It will close the program if the file has been saved. If the STD has not been saved, it will open another window, asking the user if he wants to save the STD, to exit without saving, or to cancel the exit function. If the user selects save, it will run the save function, if exit without saving is selected, then the program will just close. 

     Alternative Paths
If the user selected Exit by mistake, the user can cancel the exit function by selecting in the pop-up window cancel, or by pressing the escape key.

Post-Conditions
The program exits and frees memory used 

Related Use Cases


     Used Use Cases


Extending Use cases


VerifySavedStatus

Description
Checks the STD file saved status, that means: Has it been saved? Under what name/path is it saved? Has there been any changes since it was last saved?

Priority
1

Status
Detailed Description

Actors
Save function and exit function

Pre-Conditions
The program is running in the machine, there is an STD open

Flow of Events


     Basic Path
It checks if there is a file linked to such STD, if there has been any modifications since it was last saved, sends the information to the function who called this function.

     Alternative Paths


Post-Conditions
The program has saved the STD on a file, with a specified file name. 

Related Use Cases


     Used Use Cases


Extending Use cases


Sequence Diagram of Exit:
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Collaboration Diagram of Exit:
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3.1.1.6 Login

Description
Ask for a username and password to allow the user to start using the software.

Priority
1

Status
Detailed Description

Actors
CEO, Marketing/sales, Consulting services

Pre-Conditions
The program is running in the machine.

Flow of Events


     Basic Path
1. The user selects her/his username from a dropdown menu.

2. The user writes her/his password.

3. The user clicks on the ‘OK’ button. 

     Alternative Paths
After step 1, the user clicks on the ‘Change Password’ button. The software opens a new window prompting the user for her/his new password (see section 3.1.1.7).

Post-Conditions
The user is logged in and can start using the software according to her/his privileges.

Related Use Cases


     Used Use Cases


Extending Use cases
Change Password

Sequence diagram of Login:
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Collaboration diagram of Login:
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3.1.1.7 Change Password

Description
Change the selected user’s password

Priority
2

Status
Detailed Description

Actors
CEO, Marketing/sales, Consulting services

Pre-Conditions
The program is running in the machine.

A user is selected in the Login window.

The user clicked on ‘Change Password’ in the Login window

Flow of Events


     Basic Path
4. The user writes her/his old password.

5. The user writes her/his new password twice.

6. The user clicks on the ‘OK’ button. 

     Alternative Paths
In step 1, the user does not write the right password and continues to steps 2 and 3. The software pops up an error message and no changes are made. The user is brought back to the main Login window.

Post-Conditions
The password is encrypted and saved in the login file. 

Related Use Cases
Login

     Used Use Cases
Login

Extending Use cases
None

Sequence diagram for Change password:
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Collaboration diagram for Change password:
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3.1.2 Details for the Tools menu functions

Use Case for the Tools Menu:
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3.1.2.1 select

Description
The user selects any objects from the STD.

Priority
1

Status
Detailed Description

Actors
CONSULTANT & MARKETING

Pre-Conditions
· Logged into system

· Opened STD

Flow of Events


     Basic Path
1. Left click on the ‘tool’ menu and left click on SELECT.

2. Point the mouse the desired object and left click on it.

Alternative Paths


N/A

Post-Conditions
· The desired object is selected

Related Use Cases


Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.2.2 addState

Description
The user adds a new state in the STD.

Priority
1

Status
Detailed Description

Actors
CONSULTANT

Pre-Conditions
· Logged into system

· Opened STD

Flow of Events


     Basic Path
1. Left click on the ‘tool’ menu and left click on ADD STATE.

2. Point the mouse to the desired position where the new state is going to be placed in the STD and left click.



Alternative Paths


N/A

Post-Conditions
· A new state is created at the desired place in the STD.

Related Use Cases


Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.2.3 addTransition

Description
The user adds a new transition arrow in the STD.

Priority
1

Status
Detailed Description

Actors
CONSULTANT

Pre-Conditions
· Logged into system

· Opened STD

Flow of Events


     Basic Path
1. Left click on the ‘tool’ menu and left click on ADD TRANSITION.

2. Point the mouse to the desired state on which the transition will come from, and left click.

3. Point the mouse to the desired state on which the transition will end, and left click.

Alternative Paths


Alternative flow of events 1:

In Step 2, the user does not initially click on a state. No transition is created, and the process is stopped.

Alternative flow of events 2:

In Step 3, the user does not click on a state. No transition is created, and the process is stopped.

Post-Conditions
· A new transition arrow is created at the desired place in the STD.

· The concerned (related) states are updated (internally).

Related Use Cases


Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.2.4 Delete

Description
The user deletes any object from the STD.

Priority
1



Status
Detailed Description



Actors
CONSULTANT

Pre-Conditions
· Logged into system

· Opened STD with at least one object

Flow of Events


     Basic Path
1. Left click on the ‘tool’ menu and left click on DELETE.

2. Point the mouse to the desired object and left click.



     Alternative Paths




Post-Conditions
· The object is deleted.

· The concerned (related) objects are updated (internally).

Related Use Cases


Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.2.5 commentBox

Description
The user writes comments anywhere in the STD.

Priority
1

Status
Detailed Description



Actors
CONSULTANT & MARKETING

Pre-Conditions
· Logged into system

· Opened STD

Flow of Events


     Basic Path
1. Left click on the ‘tool’ menu and left click on COMMENT.

2. Left click in the STD where the user wants the comments to be written.

3. The mouse pointer changes to a cursor.

4. The user writes the comment.

5. Left click anywhere but in the active comment box to deactivate it and terminate.



Alternative Paths


Alternative flow of events 1:

In Step 2, the user clicks in the area of an existing text field. The text field is activated and the user can edit it. (then go back to the basic flow of events at step 3)



Post-Conditions
· A text field containing comments is displayed on the STD.

Related Use Cases


Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.2.6 moveObject

Description
The user moves a state or a comment field anywhere in the STD. In the case of a state, it will affect all of its transition arrows from or to different states and these transition arrows will shrink or expand accordingly to the displacement.

Priority
1



Status
Detailed Description



Actors
CONSULTANT & MARKETING

Pre-Conditions
· Logged into system

· Opened STD

· Object selected (active). 

Flow of Events


     Basic Path
1. Drag the mouse to place the object in the desired position in the STD.

Alternative Paths




Post-Conditions
· The selected object is being moved to the desired position in the STD.

Related Use Cases


Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.2.7 checkConsistency

Description
The user utilizes this function to verify the correctness of the DFA. The function will automatically check in the STD corresponds to the DFA definitions. If the STD is inconsistent, the system will popup a window pointing out the errors.



Priority
1

Status
Detailed Description



Actors
Marketing, Consulting 



Pre-Conditions
There must be an opened STD with at least one state and one transition.

Flow of Events


     Basic Path
1. User activates the function.

2. The system checks if there is 0, 1 or more initial states.

3. The system checks if there is 0, 1 or more final states.

4. The system validates all the states by verifying if there is one instance of every type of transitions outgoing from each state.

5. If the STD fits into those rules, the system pops up a message saying that the STD is a valid DFA.



Alternative Paths


Alternative flow of events 1:

In Steps 2, 3 & 4, the system finds inconsistencies. The basic path halts and the system pops up a message that identifies the inconsistency with a hint on how to fix the STD. The message also points out that the consistency check could not be completed. 



Post-Conditions
None

Related Use Cases
None

     Used Use Cases
None

Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.3 Details for the Property functions

Use case for the Properties:
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3.1.3.1 viewStateDescription

Description
The user has to select a state object from the canvas or the state list to get into the detailed view of this particular state.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User selects only one state on the canvas or

User selects a state in list and validates it.

2) The system validates the state ID

The user is brought to the description tab view where the characteristics of this state are displayed.

     Alternative Paths


Alternative flow of events 1:

In Step 2, the state ID is not validated and the user is asked to select only one state. In addition, the state description view is changed in grey style (cannot manipulate internal controls).

Post-Conditions
The user is now looking at the detailed state view.

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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Inner Specification Requirement:

3.1.3.1.1 setName

Description
This function lets the user specify a name for the state that she/he selected.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User clears the actual name

2) User writes down the new name for the selected state

3) User applies by clicking on the “Apply” button

4) The system stores the new state name

     Alternative Paths


Alternative flow of events 1:

In Step 3, the new name is not validated that is memorized if the user does not apply. Thus, last name remains still stored.

Post-Conditions
The new name of the selected state is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.1.2 setColour

Description
This function lets the user specify a colour for the state that she/he selected. Only the outline will have this colour. The rest of the state will be in the colour of the background.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User clicks on the colour control

2) User selects a colour

3) User applies by clicking on the “Apply” button

4) The system stores the new state colour

     Alternative Paths


Alternative flow of events 1:

In Step 3, the new colour is not validated that is memorized if the user does not apply. Thus, last colour remains still stored.

Post-Conditions
The new colour of the selected state is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

In this software, it is possible to have a state transition diagram that accepts a state with the initial and the final status.

3.1.3.1.3 setInitialState

Description
This function lets the user specify if the selected state is the initial state or other type of state. Only one state can be an initial state

Priority
1

Status
Detailed Description

Actors
CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User clicks on the check box control

2) User applies by clicking on the “Apply” button

3) The system stores the new type of state

     Alternative Paths


Alternative flow of events 1:

In Step 2, the new type for the state is not validated that is memorized if the user does not apply. Thus, last type remains still stored.

Post-Conditions
The new type of the selected state is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.1.4 setFinalState

Description
This function lets the user specify if the selected state is a final state or other type of state. It is possible to have many final states in the state transition diagram.

Priority
1

Status
Detailed Description

Actors
CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User clicks on the check box control

2) User applies by clicking on the “Apply” button

3) The system stores the new type of state

     Alternative Paths


Alternative flow of events 1:

In Step 2, the new type for the state is not validated that is memorized if the user does not apply. Thus, last type remains still stored.

Post-Conditions
The new type of the selected state is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.1.5 viewInputs

Description
This function lets the user see what transitions come from another states and go to this particular state.

The user can only visualize their transition name and ID.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
The user scrolls down or up the scroll control of the read only edit text control in order to see what are the inputs.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.1.6 viewOutputs

Description
This function lets the user see what transitions leave this particular state and go to another states.

The user can only visualize their transition name and ID.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
The user scrolls down or up the scroll control of the read only edit text control in order to see what are the outputs.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.1.7 setComment

Description
This function lets the user comments the actual state.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) The user fills in the text control comments that she/he would like to add.

2) User applies by clicking on the “Apply” button

4) The system stores new state comments

     Alternative Paths


Alternative flow of events 1:

In Step 2, new comments for the state are not validated that is memorized if the user does not apply. Thus, last comments remain still stored.

Post-Conditions
New comments of the selected state are stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.2 viewTransitionDescription

Description
The user has to select a transition object from the canvas or the transition list to get into the detailed view of this particular transition.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One transition has to be already drawn and selected

Flow of Events


     Basic Path
1) User selects only one transition on the canvas or

User selects a transition in the list and validates it.

2) The system validates the state ID

3) The user is brought to the description tab view where the characteristics of this transition are displayed.

     Alternative Paths


Alternative flow of events 1:

In Step 2, the transition ID is not validated and the user is asked to select only one transition. In addition, the transition description view is changed in grey style (cannot manipulate internal controls).

Post-Conditions
The user is now looking at the detailed transition view.

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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Inner Specification Requirement

3.1.3.2.1 setName

Description
This function lets the user specify a name for the transition that she/he selected.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User clears the actual name

2) User writes down the new name for the selected transition

3) User applies by clicking on the “Apply” button

4) The system stores the new transition name

     Alternative Paths


Alternative flow of events 1:

In Step 3, the new name is not validated that is memorized if the user does not apply. Thus, last name remains still stored.

Post-Conditions
The new name of the selected transition is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.2.2 setColour

Description
This function lets the user specify a colour for the transition that she/he selected.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) User clicks on the colour control

2) User selects a colour

3) User applies by clicking on the “Apply” button

4) The system stores the new transition colour

     Alternative Paths


Alternative flow of events 1:

In Step 3, the new colour is not validated that is memorized if the user does not apply. Thus, last colour remains still stored.

Post-Conditions
The new colour of the selected transition is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.2.3 viewLaunchedStates

Description
This function lets the user see what is the launched state.

The user can only visualize its state name and ID.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
Look at the static text control in order to see what is the launched state.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.2.4 viewEndingStates

Description
This function lets the user see what is the ending state.

The user can only visualize its state name and ID.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
Look at the static text control in order to see what is the ending state.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.2.5 setComment

Description
This function lets the user comments the actual transition.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
1) The user fills in the text control comments that she/he would like to add.

2) User applies by clicking on the “Apply” button

3) The system stores new transition comments.

     Alternative Paths


Alternative flow of events 1:

In Step 2, new comments for the transition are not validated that is memorized if the user does not apply. Thus, last comments remain still stored.

Post-Conditions
New comments of the selected transition are stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.3 viewStateList

Description
There is no need for the user to select a particular state object to get into the state list view.

Priority
1

Status
Detailed Description



Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
The user is brought to the state list view where an exhaustive list of states with their names and ID are described.

     Alternative Paths
None

Post-Conditions
The user is now looking at the state list view.

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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Inner Specification Requirement:

3.1.3.3.1 selectState

Description
This function lets the user see what are the states that have been already drawn on the canvas. The user can only visualize their transition name and ID (No possible modification).

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn.

Flow of Events


     Basic Path
The user scrolls down or up the scroll control of the read only edit text control in order to see what are listed states.

The system checks that the user can select only one state.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.3.2 launchStateDescription

Description
This function allows the user to see the state description view for that distinct state.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One state has to be already drawn and selected

Flow of Events


     Basic Path
User clicks on the “description” control

     Alternative Paths
None

Post-Conditions
The user is now looking at the detailed state view.

Related Use Cases


     Used Use Cases
Check the state ID, search it, then load its description

     Extending Use Cases
None

3.1.3.4 viewTransitionList

Description
There is no need for the user to select a particular transition object to get into the transition list view.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
The user is brought to the transition list view where an exhaustive list of transitions with their names and ID are described.

     Alternative Paths
None

Post-Conditions
The user is now looking at the transition list view.

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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Inner Specification Requirement:

3.1.3.4.1 selectTransition

Description
This function lets the user see what are the transitions that have been already drawn on the canvas.

The user can only visualize their transition name and ID (No possible modification).

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One transition has to be already drawn.

Flow of Events


     Basic Path
The user scrolls down or up the scroll control of the read only edit text control in order to see what are listed transitions.

The system checks that the user can select only one transition.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.4.2 launchTransitionDescription

Description
This function allows the user to see the transition description view for that distinct transition.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
One transition has to be already drawn and selected

Flow of Events


     Basic Path
User clicks on the “description” control

     Alternative Paths
None

Post-Conditions
The user is now looking at the detailed transition view.

Related Use Cases


     Used Use Cases
Check the transition ID, search it, then load its description

     Extending Use Cases
None

3.1.3.5 viewSTDDescription

Description
The user must have opened a previous file related with that software or create a new diagram to get into the general DFA description view.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
1) User selects the menu tool “Tool”

2) The system displays the property window at the correct tab that is the “About DFA” tab view.

Or

User selects only the “about DFA” tab if she/he has been already on the property window.

The user is brought to the description tab view where the characteristics of the DFA are displayed.

     Alternative Paths


Alternative flow of events 1:

No diagram has already been created or no file has already been loaded.

Post-Conditions
The user is now able to view the main characteristics of the actual state transition diagram.

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

Inner Specification Requirement:

3.1.3.5.1 setName

Description
This function lets the user specify a name for the state transition diagram that she/he would like to title.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
1) User clears the actual name

2) User writes down the new name for the selected transition

3) User applies by clicking on the “Apply” button

4) The system stores the new diagram name

     Alternative Paths


Alternative flow of events 1:

In Step 3, the new name is not validated that is memorized if the user does not apply. Thus, last name remains still stored.

Post-Conditions
The new diagram name is stored at the specific state ID

Related Use Cases


     Used Use Cases
Search by ID number

     Extending Use Cases
None

3.1.3.5.2 viewStateNumber

Description
This function lets the user see how many states there are in the diagram: that one is a simple integer number.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
Look at the static text control in order to see the total number of states.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.5.3 viewTransitionNumber

Description
This function lets the user see how many transitions there are in the diagram: that one is a simple integer number.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
Look at the static text control in order to see the total number of transitions.

     Alternative Paths
None

Post-Conditions
None

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.5.4 setComment

Description
This function lets the user comments the actual state transition diagram.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
1) The user fills in the text control comments that she/he would like to add.

2) User applies by clicking on the “Apply” button

3) The system stores the new comments.

     Alternative Paths


Alternative flow of events 1:

In Step 2, new comments for the diagram are not validated that is memorized if the user does not apply. Thus, last comments remain still stored.

Post-Conditions
New diagram comments are stored at the specific state ID

Related Use Cases


     Used Use Cases
None

     Extending Use Cases
None

3.1.3.6 Apply

Description
The user clicks on that button in order to save all modified data such as names, comments, colours and state status in memory.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
User clicks on the “Apply” control

     Alternative Paths
None

Post-Conditions
Data are now saved in memory according to state and transition ID.

Related Use Cases


     Used Use Cases
Check state Ids and transition IDs, search them, then save them

     Extending Use Cases
None

Sequence diagram:

[image: image40.wmf] : MARKETING or 

CONSULTANT

property

canvas

[modify attributes and] apply

set

refreshSTD


Collaboration diagram:
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3.1.3.7 Ok

Description
The user clicks on that button in order to save all modified data such as names, comments, colours and state status in memory and close the Property Dialog window.

Priority
1

Status
Detailed Description

Actors
MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
User clicks on the “Ok” control

     Alternative Paths
None

Post-Conditions
1) All data are saved

2) Properties window is then closed 

Related Use Cases


     Used Use Cases
Check state Ids and transition IDs, search them, then save them

     Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.3.8 Cancel

Description
The user has to click on that button in order to cancel all changes made after the last time s/he clicked on “Apply”. This function then closes the properties window.

Priority
1

Status
Detailed Description

Actors
CEO, MARKETING and CONSULTANT

Pre-Conditions
None

Flow of Events


     Basic Path
User clicks on the “Cancel” control

     Alternative Paths
None

Post-Conditions
1) Properties window is then closed 

Related Use Cases


     Used Use Cases
Check state Ids and transition IDs, search them, then save them

     Extending Use Cases
None

Sequence diagram:
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Collaboration diagram:
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3.1.4 Details for the Help menu
These functions are simple and for general use, meaning that all users have access to them. The help file is in html format, so it will open an instance of a web browser (a txt file is also available in case the computer has no web browser). 

Details for the Help menu functions

About

Description
Will display the information of the developers of the software, along with version of the software and other information

Priority
1

Status
Detailed Description

Actors
CEO, Marketing/sales, Consulting services

Pre-Conditions
The program is running in the machine

Flow of Events


     Basic Path
-With the mouse the user clicks on Help menu, which opens the menu, where the user then clicks About. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the Help menu, select About and hit the Enter key. 

Any of these options will make a small window pup-up, with the information and one button to close it.

     Alternative Paths


Post-Conditions
The about window opens and is visible until it is closed by the user

Related Use Cases


     Used Use Cases


Extending Use cases


Help

Description
The help command opens an instance of the main web browser installed on the machine.

Priority
1

Status
Detailed Description

Actors
CEO, Marketing/sales, Consulting services

Pre-Conditions
The program is running

Flow of Events


     Basic Path
-With the mouse the user clicks on Help menu, which opens the menu, where the user then clicks Help. Or

-By pressing the Alt key, the menus are sensible to key navigation, with the arrows the user can open the Help menu, select Help and hit the Enter key. 

Any of these options will start the help html file on the main web browser installed on the computer.

     Alternative Paths


Post-Conditions
The help html file is opened on the web browser 

Related Use Cases


     Used Use Cases


Extending Use cases


Use Case for Help menu functions:
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Sequence diagram for About: 
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Collaborative Diagram for About:
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Sequence diagram for Help:
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Collaborative Diagram for Help:
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3.2 Data Dictionnary

File Menu



Function
Description
Data

Open
The Open function opens a file of a previous STD
String fileName

New
The New function creates a new canvas for a new STD
 

Save
The Save function saves the current STD on a file
String fileName

Save As
The Save As function saves the current STD on a file with a different name and/or location if the STD is already saved with another name.
String fileName

Exit
The exit function ends the program
 

Open Recent
Opens the last STD created/modified in the current machine on the program
String fileName

Login As
Changes the user in order to change the privileges
String loginName        String password





Help Menu



Function
Description
Data

About
Displays a window with information of the developing group.
 

Help
Displays a help file in html format
HTML file





Tool Menu



Function
Description
Data

commentBox
Creates a comment box.
String comment





State Description



Function
Description
Data

Name
This function lets the user specify a name for the state that she/he selected.
String stateName

Color
This function lets the user specify a color for the state that she/he selected. Only the outline will have this color. The rest of the state will be in the color of the background.
String stateColor

Initial state
This function lets the user specify if the selected state is the initial state or an other type of state. Only one state can be an initial state
String stateStatus

Final state
This function lets the user specify if the selected state is a final state or an other type of state. It is possible to have many final state in the state transition diagram.
stateStatus

Inputs
This function lets the user see what are the transitions that come from another states and go to this particular state. The user can only visualize their transition name and ID.
Array inputs[stateId]

Outputs
This function lets the user see what are the transitions that leave this particular state and go to another states.The user can only visualize their transition name and ID.
Array outputs[stateId]

Comment
This function lets the user comments the actual state.
String stateComment





Transition Description


Function
Description
Data

Name
This function lets the user specify a name for the transition that she/he selected.
String transitionName

Color
This function lets the user specify a color for the transition that she/he selected.
String transitionColor

From_States
This function lets the user see what is the launched state. The user can only visualize its state name and ID.
 

To_States
This function lets the user see what is the ending state. The user can only visualize its state name and ID.
 

Comment
This function lets the user comments the actual transition.
 





STD description



Function
Description
Data

Name
This function lets the user specify a name for the state transition diagram that she/he would like to title.
string STDName

State_Number
This function lets the user see how many states there are in the diagram : that one is a simple integer number.
int totalStates

Transition_Number
This function lets the user see how many transitions there are in the diagram : that one is a simple integer number.
int totalTransitions

Comment
This function lets the user comments the state transition diagram.
String STDComment





STD - states description



Function
Description
Data

Detail_List
This function lets the user see what are the states that have been already drawn on the main board. The user can only visualize their state name and ID (No possible modification).
array string [stateName] array int [stateId]

Launch_Description
This function allows the user to visualize the selected state property.
 





STD - transition description


Function
Description
Data

Detail_List
This function lets the user see what are the transitions that have been already drawn on the main board. The user can only visualize their transition name and ID (No possible modification).
array string [transitionId]

Launch_Description
This function allows the user to visualize the selected transition property.
 

Name
Type
Description
Length

fileName
string
Name of file
20 chars

loginName
string
User name
20 chars

password
string
User password
8 chars

stateName
string
Name of the state
20 chars

stateColor
int
Color of the state (RGB)
6 digits

stateStatus
char
Status of state, initial or final
1 char

stateId
int
Id number for state
3 digits

stateComment
string
Comment on the state
300 chars

transitionName
string
Name of the transition
20 chars

transitionComment
string
Comment on the transition
300 chars

transitionId
int
Id number of the transition
3 digits

transitionColor
int
Color of the transition (RGB)
6 digits

STDName
string
Name of the STD
20 chars

totalStates
int
Total states in the STD
3 digits

totalTransitions
int
Total transitions in the STD
3 digits

STDComment
string
General comment of the STD
300 chars

comment
string
Comment box on the canvas
300 chars






Object State




Name
string
State name
20 chars

color
int
State color (RGB)
6 digits

posx
int
Position X on canvas
4

posy
int
Position Y on canvas
4

height
int
size of height
3

width
int
width size
3

TransitionsIn
transitionId
list/array/pointer to transitions(input)


TransitionsOut
transitionId
list/array/pointer to transitions(output)







Object Transition




Name
String
Transition name


color
Int
Transition color (RGB)
6 digits

posXi
int
initial X position of arrow
4

posYi
int
initial Y position of arrow
4

posXf
int
final X position of arrow
3

posYf
int
final Y position of arrow
3

stateI
stateId
reference to its initial State


stateF
stateId
reference to its final state


3.3 External Interface Requirements

This section describes the user, hardware, software, and communications interfaces for the STDD3000.

3.3.1 User Interfaces

Main Window:

The main window contains three important parts: the canvas, the menus, and the toolbox (GUI version of the menu). We incorporated the toolbox for a quick access to important functions of the software.
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Fig 3.3.1.1: STDD3000 main window
File Menu:

The File menu contains the following options: New (create a new canvas), Open… (open an existing canvas saved in some file), Save & Save As… (save the current canvas), and Exit (exit STDD3000).
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Fig 3.3.1.2: STDD3000 File menu
Tool Menu:

The Tool menu contains the following options: Select (change the mouse pointer to the Select function), Add State (change the mouse pointer to the Add State function), Add Transition (change the mouse pointer to the Add Transition function), Delete (change the mouse pointer to the Delete function), Comment Box (change the mouse pointer to the Delete function), Check Consistency (check the consistency of the opened STD), and Property… (open the Property Dialog window for either the currently selected object or the whole STD (same window, but different tab)).
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Fig 3.3.1.3: STDD3000 Tool menu
Help Menu:

The Help menu only contains two options: Help…, and About…. Help will open a help file in the form of a web page. About will open the About window as you can see below.
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Fig 3.3.1.4: STDD3000 Help menu
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Fig 3.3.1.5: STDD3000 About Window
Open and Save/Save As… windows:

The Open and Save/Save As… windows are typical Microsoft Windows windows. They use operating system functionalities to allow the user to perform several file management functions.
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Fig 3.3.1.6: STDD3000 Open window
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Fig 3.3.1.7: STDD3000 Save/Save As… window

Toolbox:

The Toolbox contains the major functionalities of the software in the form of icons. Those functions can also be accessed through the Menu. We decided to add this to improve the accessibility of those functions.
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Fig 3.3.1.8: STDD3000 Toolbox

Property Dialog window:

The Property Dialog window allows the user to view/alter several properties of the diagram. The About STD tab contains important information about the STD itself. The List of Transitions and List of States tabs contain a list of all the transitions/states where the user can select one and click on the ‘Show description’ button to switch to the State/Transition Description tab for the selected Transition/State. The State/Transition Description tab contains specific information about the currently selected state/transition (whether it was selected in the List of Transitions/States or in the canvas). This information can be viewed or edited depending on the privileges of the user. 

At any time the user can click on ‘OK’ (depending on to his/her privileges) to apply any changes made to the properties and close the Property Dialog window. Similarly, s/he can click on ‘Cancel’ to close the Property Dialog window without applying any changes to the STD. Again, depending on his/her privileges, clicking on ‘Apply’ will apply changes made to the properties of the STD.
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Fig 3.3.1.9: STDD3000 About STD tab
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Fig 3.3.1.10: STDD3000 List of Transitions tab
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Fig 3.3.1.11: STDD3000 List of States tab
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Fig 3.3.1.12: STDD3000 State Description tab
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Fig 3.3.1.13: STDD3000 Transition Description tab

3.3.2 Hardware Interfaces

STDD3000 will interface with the hardware when opening and saving files. We will use simple system calls for those functions.

3.3.3 Software Interfaces

STDD3000 will be running on a machine with Microsoft Windows 2000 Professional. It will use Microsoft Internet Explorer to display the Help files.

3.3.4 Communication Interfaces

STDD3000 shall not interface with any communication device.

3.4 Performance Requirements

· STDD3000 shall support a STD with 1000 states and 1000 transitions. 

· It shall perform the consistency check in a fairly short amount of time. The algorithm will perform the check in s+(s*t) units of time where ‘s’ is the number of states and ‘t’ is the number of transitions.

· The saved STD file shall not take more than s*t/2 kBytes where ‘s’ is the number of states and ‘t’ is the number of transitions.

3.5 Design Constraints

None.

3.6 Software System Attributes

3.6.1 Availability

STDD3000 shall never be down so long as the computer running the program is functional and the program and data files are not corrupted in any way.
3.6.2 Security

The different types of users shall only be able to use the functions assigned to them. For example, the CEO should never be given the possibility to click on the ‘Apply’ button in the Property Dialog window.

3.6.3 Maintainability

The software shall be maintainable by altering the different objects in the source code.

3.6.4 Learnability

Any user shall be able to learn how to use STDD3000 within 20 minutes. Afterwards, the user shall be able to look at the help files for hints on how to use specific functionalities.

3.7 Other Requirements

4. Appendices

4.1. Log Files

